
Morningstar Direct Release Notes May 1, 2017
OverviewThis document covers the following new features and enhancements in 
Morningstar DirectSM and Morningstar DirectSMCloud.

In the Research app… Go to…

The following new features are available in the Research app:

g New webinar, Financial Regulation in the Age of Trump
g Monthly U.S. Fund Category Return Scorecard
g Monthly U.S. Fund Return Snapshot
g Quarterly U.S. Asset Flows Wrap Up, and
g New publication, Stock Strategist.
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In Morningstar Categories… Go to…

The following changes have been made in Morningstar Categories:

g Morningstar Categories have changed due to the semi-annual 
category review

g 2017 Global Categories are now assigned based on specific characteristics 
of the strategy, and

g The GBP Allocation categories have been recalculated from the current 
three-tiered structure (Cautious, Moderate, and Aggressive) to five tiers 
(Cautious, Moderately Cautious, Moderate, Moderately Adventurous, 
and Adventurous).
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Morningstar Direct Release Notes May 1, 2017 1
© 2017 Morningstar. All Rights Reserved.

https://direct.morningstar.com/research/doc/Apr%2004%202017_Webinar_Financial_Regulation_in_the_Age_of_801417
https://direct.morningstar.com/research/doc/Apr%2005%202017_March_2017_Morningstar_Direct_Cloud_US_Fund_Category_Return_801603
https://direct.morningstar.com/research/doc/Apr%2005%202017_March_US_Fund_Return_Snapshot_A_Mixed_End_To_A_Solid_801615
https://direct.morningstar.com/research/doc/Apr%2013%202017_US_Asset_Flows_Q1_Wrap_Up_in_9_802581
https://direct.morningstar.com/research/publication/803109


Morningstar Direct Release Notes May 1, 2017 Overview
In Morningstar Data and Methodology… Go to…

The following changes have been made in Morningstar data and methodology:

g Updated historical market price data
g Updated Morningstar fee-level methodology
g New data points for Taiwan AFS Funds
g New fixed-income data points
g New data point for non-US stocks
g Removal of a duplicate data point in the UK Investment Trusts universe
g Retirement of fourteen ISA Categories in Israel Funds
g Enhanced logic for segregating Korean funds into the correct universes
g Coming in 2017: Methodology enhancements to fixed-income analytics, 

fund category averages and percentile rankings, and Equity Style Box, and
g Postponement of Sustainability Rating methodology changes.

page 11

In Presentation Studio… Go to…

The following new features are available in Presentation Studio:

g Select a language preference in Application Settings, as well as in 
individual reports and templates

g Rank supplementary data points in Performance Reporting 
table components

g Link text components to specific font settings, and
g Customize the names of Morningstar indexes.

page 16

In Report Portal… Go to…

You can now specify the order of factsheets in a batch output. page 29

In Morningstar Direct Desktop… Go to…

The following changes have been made in Morningstar Direct Desktop:

g The Morningstar Publications tab has been retired, so you must access 
Morningstar Publications via Morningstar Direct Cloud, and

g You can access the Equity SAL report from the Equity Quicktake.

page 33

In Morningstar Excel Add-In… Go to…

The following new features are available in the Morningstar Excel Add-In

g An option to disable automatic calculations, and
g Currency conversion for all NAV-related data points.

page 36
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New in the Research App Overview
New in the Research App

OverviewIn this section, you will learn about these additions to the Research app:

gWebinar: “Financial Regulation in the Age of Trump” (page 3)
gMonthly U.S. Fund Category Return Scorecard (page 4)
gMonthly U.S. Fund Return Snapshot (page 5)
gQuarterly U.S. Asset Flows Wrap Up (page 5), and
gPublication: Stock Strategist (page 6).

How can I learn more 
about financial regulation 
under President Trump?

The webinar, “Financial Regulation in the Age of Trump,” is now available in the 
Research app at Publications…Webinars. 

The webinar is approximately 45 minutes long.

Note the highlighted selections
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New in the Research App What is the monthly US Fund Category Return Scorecard?
What is the monthly 
US Fund Category 
Return Scorecard?

Morningstar now publishes a monthly US Fund Category Return Scorecard, a 
table-based look at recent trends among U.S. fund category returns.

To access the US Fund Category Return Scorecard, go to Latest…Thematic…March 
2017 Morningstar Direct Cloud US Fund Category Return Scorecard.

 Note: The article can also be found on the author’s page.

Knowing the date of 
the article helps you 
decide how far to 
scroll down
Morningstar Direct Release Notes—May 1, 2017 4
© 2017 Morningstar. All Rights Reserved.

https://direct.morningstar.com/research/author/1953


New in the Research App What is the monthly U.S. Fund Return Snapshot?
What is the monthly U.S. 
Fund Return Snapshot?

Morningstar now publishes a monthly U.S. Fund Return Snapshot, a chart-based look 
at recent trends among U.S. fund categories.

To access the US Fund Category Return Scorecard, go to Latest…Thematic…March 
U.S. Fund Category Return Snapshot: A Mixed End to A Solid Quarter.

 Note: The article can also be found on the author’s page.

Knowing the date of 
the article helps you 
decide how far to 
scroll down
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New in the Research App What is the quarterly U.S. Asset Flows Wrap Up?
What is the quarterly U.S. 
Asset Flows Wrap Up?

Morningstar now publishes a quarterly U.S. Asset Flows Wrap Up, a chart-based look 
at trends in asset flows. 

To access the latest wrap up in the Research app, go to Topics…Asset Flows.

What is the 
new publication 
“Stock Strategist?”

“Stock Strategist” makes it easy to find Morningstar’s stock strategy for equity-covered 
content. You will find in-depth articles on the outlook for individual stocks and 
industries, authored by Morningstar equity analysts.

To access “Stock Strategist,” in the Research app, go to Publications…
Stock Strategist.

Scroll down to find 
Stock Strategist
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New in Morningstar Categories Overview
New in Morningstar Categories

OverviewMorningstar categories are updated to respond asset allocation trends and fund 
manager purchasing decisions.

In this section, you will learn about the following:

gMorningstar Category changes due to the semi-annual category review (page 7)
g the reason for the global category reassignments (page 9)
g the reasons for the recalculated category averages and ranks for EAA GBP 

Allocation categories (page 9), and
g the impact of the recalculated category averages and ranks for EAA GBP Allocation 

categories (page 10).

What changes resulted 
from the Morningstar 
Category review?

As a result of the semi-annual Morningstar Category review, effective April 28, 2017, 
categories in the following regions have changed:

gU.S.
g Europe/Asia/Africa
gBrazil
gChina
g India
gSouth Korea, and 
gMexico. 

Please click on the links in the following table for summary and ID mapping documentation.

Domicile/Region Universes Changes Effective April 28, 2017

United States g US Open End Funds
g Variable Annuities
g Exchange-Traded Funds
g Closed End Funds
g Separate 

Accounts/CITs, and 
g Unit Investment Trust

In US Retail:

g new category: World Small/Mid Stock
g renamed category World Stock to 

World Large Stock with updated 
benchmarks

g one retired category: Commodities 
Miscellaneous, and

g revised definition: Nontraditional 
Bond

 Note: In previous notifications, the new 
and renamed categories were assigned 
different names than those currently 
assigned. Additionally, the renamed 
category, World Large Stock, has 
undergone benchmark changes. Click 
here for details.
Morningstar Direct Release Notes—May 1, 2017 7
© 2017 Morningstar. All Rights Reserved.

http://advisor.morningstar.com/Enterprise/VTC/2017.04.28_CategoryChanges_US.xlsx


New in Morningstar Categories What changes resulted from the Morningstar Category review?
Europe, Africa, 
and Asia (EAA)

g Open End Funds
g Closed End Funds, and 
g Exchange-Traded Funds 

In EAA funds:

g three new GIFs categories, and 
g one renamed GIFs category.

Click here for changes to international 
categories.

Brazil Open End Funds In Brazil open-end funds:

g one new category
g four renamed categories, and 
g modified definitions for two 

categories. 

Click here for changes to international 
categories.

China g Open End Funds
g Closed End Funds, and
g Exchange-Traded Funds

In China funds:

g four new categories
g two retired categories, and
g revised category average calculation 

methods for seven existing 
categories. 

Click here for changes to international 
categories.

India g Open End Funds, and
g Closed End Funds

In India funds:

g two new categories, and 
g modified definitions for three 

categories.

Click here for changes to international 
categories.

South Korea g Open End Funds, and
g Exchange-Traded Funds

One new category (Target Achievement)

Click here for changes to international 
categories.

Mexico g Open End Funds, and
g Pension Funds

Six new categories

Click here for changes to international 
categories.

Domicile/Region Universes Changes Effective April 28, 2017
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New in Morningstar Categories Why have Morningstar Global Categories been reassigned?
Why have Morningstar 
Global Categories 
been reassigned?

The Morningstar Global Category assignments help investors search for similar 
investments domiciled across the globe. Morningstar Global Categories are mapped 
into ten global broad category groups (Equity, Allocation, Convertibles, Alternative, 
Commodities, Fixed Income, Money Market, Tax Preferred, Property, and 
Miscellaneous). They are based on the investment vehicles’ underlying local 
Morningstar Category assignments. 

As of April 30, 2017, Morningstar Global Category assignments are no longer based 
solely upon a one-to-one relationship with the local Morningstar Category. The 
Morningstar Global Category classification is now based on the specific characteristics 
of the strategy, as determined by a mosaic of all available data. 

New assignment criteria include, but are not limited to, the following factors:

g three- and five-year average portfolio characteristics
g returns-based style analysis
g reported benchmarks
g reported strategy descriptions
g local industry classifications
gMorningstar StrategyId, and 
g current Morningstar Category.

These assignments are periodically monitored by our global, multi-lingual analyst 
teams. Please contact your Relationship Manager with any questions. 

Why have the 
ranks and category 
averages for EAA GBP 
Allocation categories 
been recalculated?

The GBP Allocation categories have been recalculated from the current three-tiered 
structure (Cautious, Moderate, and Aggressive) to five tiers (Cautious, Moderately 
Cautious, Moderate, Moderately Adventurous, and Adventurous).

Due to the fundamental nature of the change, the history of category averages and 
fund ranks for those sectors have been recalculated. These changes are driven by a 
number of factors, including the following:

gRegulators have increased their scrutiny on the sales practice of investment 
products to ensure suitability (through regulation, such as MIFID II);

g The UK has an established a market for the risk assessment of multi-asset funds; 
g The UK has a vibrant independent financial adviser market with less vertical 

integration than the rest of Europe. This freedom of choice requires better tools to 
evaluate the whole of market; and

g The UK has experienced regulatory change via RDR so consideration of the “whole 
of market” and suitability is a more significant issue at this time.
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New in Morningstar Categories What universes and markets are affected by the recalculation of the EAA GBP Allocation category 
What universes 
and markets 
are affected by 
the recalculation 
of the EAA GBP 
Allocation category 
averages and ranks?

In the open-end universes of the European, African, and Asian markets, the impacted 
information includes the following:

gGBP category average indexes (daily and monthly)
g trailing returns, and
gpoint-in-time values.

This change will not require you to make any specific changes; the recalculated data 
will flow through automatically. If you currently have funds assigned to the GBP 
Allocation categories, be aware that the historical category average performance and 
percentile ranks have likely changed.
Morningstar Direct Release Notes—May 1, 2017 10
© 2017 Morningstar. All Rights Reserved.



New in Morningstar Data and Methodology Overview
New in Morningstar Data and Methodology

OverviewMorningstar monitors and updates its data and methodologies to respond to changes 
in regulations and ensure the accuracy of the data supplied to users.

In this section, you will learn about the following:

gupdated historical market price data (page 11)
gupdated Morningstar fee-level methodology (page 11)
gnew data points for Taiwan AFS Funds (page 12)
gnew fixed-income data points (page 13)
gnew data point for non-US stocks (page 14)
g removal of a duplicate data point in UK Investment Trusts (page 14)
g retirement of 14 ISA categories for Israel Funds (page 14)
g enhanced logic for segregating Korean funds to the appropriate universes 

(page 14)
gupcoming methodology enhancements (page 14), and 
gpostponement of changes to the Sustainability Rating methodology (page 15).

Why have 
historical market 
price data changed?

The data for historical market prices have been updated by backfilling missing data and 
updating for historical corrections, where necessary. The project currently focuses on 
securities traded on eleven exchanges globally, and will potentially affect five 
closed-end funds, 17 exchange-traded funds, and 4,664 equities. As a result, historical 
market prices, market returns, and Daily Market Return Index (DMRI) values will 
change in both fund and equity data products. Click here for a the list of potentially 
impacted securities. Please contact your Relationship Manager with any questions.

 Note: Similar projects targeting other markets and exchanges will take place throughout the 
remainder of 2017.

Why has the 
Morningstar fee-level 
methodology changed? 

Due to recent regulatory proposals and industry changes, the Morningstar fee-level 
methodology now uses Prospectus Net Expense data to rank share classes within a 
fee-level group (broad or distribution), and to produce the Morningstar fee-level and 
associated percentile ranks. Prior to this release, the methodology used Annual Report 
Net Expense data for the calculation. This change applies to U.S.-domiciled funds only; 
all other markets will continue to reflect the existing methodology. 

Morningstar has made this change in response to recent regulatory proposals and 
industry changes. 

The methodology change will improve fund comparisons in the following ways:

g reflect fee cuts more quickly (annual report figures can be up to 15 months old)
g include newly incepted share classes (which do not yet have an annual report) in 

the ranking groups, and
guniformly include acquired fund fees in the comparisons, regardless of 

fund-of-funds status.

Please contact your Client Service Consultant with any questions.
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New in Morningstar Data and Methodology What new data points have been added for Taiwan AFS Funds?
What new data points 
have been added for 
Taiwan AFS Funds?

SITCA, the Taiwan fund authority, regulates fund companies to ensure distribution 
yield is calculated consistently and figures are disclosed regularly. SITCA has stipulated 
that all funds must disclose their dividend yields and follow a specific equation.

To support SITCA regulations, the following new data points have been added:

The new data points are available in the following universes and modules:

g Taiwan open-end universes
g Taiwan ETF universes
gGlobal open-end universes
gGlobal ETF universes
gWorkspace, and
gPerformance Reporting.

The new data points have been added to Views as described in this table:

Data Point Definition

SITCA Yield SITCA Yield estimates a fund’s annual income per share yield. For funds 
issuing monthly dividends, the most recent income distribution is 
multiplied by 12 and then divided by the fund’s net asset value (NAV) as 
of the previous business day of ex-date. For funds issuing quarterly 
dividends, the most recent income distribution is multiplied by four and 
then divided by the fund’s NAV of previous business day of ex-date. 
Special dividends are handled in a similar manner. 

SITCA Yield Date The as-of date of the SITCA Yield data point

Universes View

Taiwan open-end and ETF universes Snapshot

Global open-end and ETF universes Operations
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New in Morningstar Data and Methodology What new data points have been added for fixed-income funds?
What new data 
points have been added 
for fixed-income funds?

Prior to this release, data points for fixed-income holdings in fund portfolios were 
offered as surveyed data points. Going forward, the following data points reflect 
calculated analytics:

The new data points are available in the following Global universes:

gOpen-end, closed-end, and ETF funds
gSeparate Accounts
g Insurance
gMoney Market Funds
gUS Variable Annuity Subaccounts
gUS Variable Life Subaccounts
gUnit Investment Trust, and
gUK LP Funds (open-end and ETF).

The new data points are available in the following features:

g investment lists
g search, and
gPerformance Reporting module.

The new data points have been added to Views as described in the following table:

 Note: Historical data is calculated monthly.

gCredit Qual Date (Calculated) gCredit Qual AAA % (Calculated)

gCredit Qual AA % (Calculated) gCredit Qual A % (Calculated)

gCredit Qual BBB % (Calculated) gCredit Qual BB % (Calculated)

gCredit Qual B % (Calculated) gCredit Qual Below B % (Calculated)

gCredit Qual Not Rated % (Calculated) gAverage Effective Duration 
(Calculated) 

gAverage Effective Maturity 
(Calculated) 

gAverage Modified Duration 
(Calculated) 

gAverage Yield to Maturity 
(Calculated) 

gAverage Effective Duration 
(Calculated) - Percent of Assets 

gAverage Effective Maturity 
(Calculated) - Percent of Assets 

gAverage Modified Duration 
(Calculated) - Percent of Assets 

gAverage Yield to Maturity 
(Calculated) - Percent of Assets

Type of Data View

Current Fixed-Inc Portfolio Statistics

Historical Historical Portfolio Data
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New in Morningstar Data and Methodology What is the new data point for non-U.S. stock?
What is the new data 
point for non-U.S. stock?

The data point Analysis Date has been added to correspond to rating data for 
non-U.S. stocks.

Analysis Date is found in the Snapshot view in the following non-U.S. universes:

gOpen End Funds
gClosed End Funds
g Exchange-Traded Funds, and 
gStocks.

What duplicate data 
point has been removed 
from the UK Investment 
Trusts universe?

In the UK Investment Trusts universe, the Association of Investment Companies (AIC) 
sector names were changed some time ago. For example, “global growth” was 
renamed “global.” A duplicate of the data point “Association of Investment Companies 
(AIC) Sector” showing the outdated sector names has been removed.

What changes have been 
made in Israel Funds?

Fourteen ISA categories have been retired.

What is the enhanced 
logic for Korean funds?

In Morningstar Direct, Korean pages are maintained with two universes: Korea OE fund 
and Korean restricted fund, for Korean public placement funds and private placement 
funds, respectively.

Traditionally, the “restricted fund” tag (also known as the “dedicated fund” tag) was 
used to distinguish the two universes. That tag can no longer be used due to the 
introduction of investment profiles as sub-types of restricted investors. 

The logic used to segregate the funds now takes the different investment profile types 
into account.

What methodology 
enhancements are 
coming up in 2017?

The planned updates for 2017 are described in this table.

Planned Update Details

Fixed-Income 
Analytics

In the first half of 2017, surveyed fixed-income data for managed 
investments (such as mutual funds and ETFs from asset managers) 
will be supplemented by Morningstar’s calculated analytics. This 
enhancement improves the transparency, comparability, completeness, 
and freshness of the data. The update will also strengthen the reliability 
of the data by reducing dependency on third-party surveys. You will 
be able to more precisely assess your fixed-income exposures and with 
that knowledge, build better multi-asset portfolios. The primary data 
points will include measures of portfolio duration, maturity, and credit 
quality breakdown.
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New in Morningstar Data and Methodology Why haven’t the Sustainability Rating methodology changes happened?
In the coming months, Morningstar plans to publish methodology papers and host a 
series of webinars on all three initiatives. Please contact your Relationship Manager if 
you have any immediate questions.

Why haven’t 
the Sustainability 
Rating methodology 
changes happened?

After additional analysis and discussions with market participants, the previously 
announced changes to the Sustainability Rating have been postponed.

Fund Category 
Averages and 
Percentile 
Rankings

In the second half of 2017, in Morningstar’s methodology for 
calculating category averages and percentile rankings, the bias toward 
funds with numerous share classes will be removed. The new approach, 
known as fractional weighting, is more consistent with the current 
methodology of the Morningstar Rating for Funds. In markets where 
fractional weighting is not already being used (including the U.S.), 
fractional weights will be applied to multiple share classes of the same 
fund to determine category averages and percentile rankings. The new 
methodology will ensure funds within a category will have an equal 
effect on these statistics.

Equity Style Box In the second half of 2017, the methodology of the Equity Style Box will 
be enhanced to globally improve quality and consistency. Transparency 
and validity of the Value-Growth scores will be increased by the 
following changes:

g a greater emphasis on higher quality, more widely available 
inputs, and 

g elimination of the reliance on consensus growth estimates. 

Value-Growth scores will update daily, and enable greater 
comparability by allowing stocks and funds from all regions to be 
plotted on a single Style Box, rather than requiring separate coordinate 
planes by geographic region. No reduction in coverage is expected. The 
primary data points affected include the following:

g Value-Growth Score for funds
g Value-Growth Score for stocks, and 
g Morningstar Style Box assignment.

Planned Update Details
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New in Presentation Studio Overview
New in Presentation Studio

OverviewIn this release, Presentation Studio offers the following new features:

gYou can now select a language preference in Application Settings, as well as in 
individual reports and templates;

g In Performance Reporting table components, you can now rank supplementary 
data points;

g It is now easy to ensure visual consistency by linking your text components to 
specific font settings; and

gYou can now customize the display names of Morningstar indexes.

In this section, you will learn how to do the following:

gunderstand the purpose of language preferences (page 17)
g select a language preference in Application Settings (page 18)
g select a language preference for a report or template (page 20)
gupdate an existing report or template to match your language selection (page 21)
gunderstand how language preference affects a template in Report Portal (page 22)
g rank supplementary data points in a Performance Reporting table component 

(page 24)
g select font settings at the Workbook level for text components (page 24)
g apply Workbook-level font settings to existing text components (page 25)
g change font settings for an individual text component (page 26)
g restore a text component’s font settings to those in Application Settings 

(page 26), and
g customize the display names of Morningstar indexes (page 27).
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New in Presentation Studio What is the purpose of language preferences?
What is the purpose 
of language preferences?

Prior to this release, you could not set your language preference in Presentation Studio. 
That information was part of your Morningstar Direct configuration. If you shared a 
template or report with another user, when they opened it, the component labels (such 
as table column headings and charts) changed to use the language setting in their 
Morningstar Direct configuration.

You can now select your language preference in Presentation Studio Application 
Settings, separate from Morningstar Direct. When you select a language, labels in 
reports and templates you create will display in your selected language, regardless of 
the language preference of others who use your reports or templates. You also have 
the option of allowing other users’ language preferences to override yours.

You can make similar language preference selections for a report or template you 
create. The selection at the report or template level overrides your selection at the 
application level.

 Note: Application-level language preference also controls Presentation Studio commands, 
drop-down menus, tab names, and component names.

Certain elements in components they retain their original language, regardless of the 
user’s language preference. Some of those elements are as follows:

g table titles
g chart titles
g text components
g fund and investment names, and
gMorningstar Category names.

The default selection (Follow 
User Preferences) allows the 
language preference of the 
user working with your 
templates or reports to 
override the language you 
originally used

The language you select 
is “locked” into all your 
reports and templates 
and will override the 
language preference of 
others who use your 
reports and templates
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New in Presentation Studio How do I select my language preference for Presentation Studio?
How do I select my 
language preference 
for Presentation Studio?

By default, the language selection in Presentation Studio Application Settings is 
“Follow User Preferences.” When others use your templates and reports, this setting 
allows their language preferences to control the language displayed.

Your language selection in Application Settings does not affect the following:

g existing reports or templates, and
gnew reports based on existing reports or templates.

 Note: For information on how to How can I update an existing report or template to match 
my Application Settings language preference? on page 21.

Your language selection in Application Settings affects only the following:

gnew reports or templates built from scratch, and
g someone else’s reports or templates you use after April 30, 2017 (provided they 

have allowed your language preference to override their own).

To select a language for component labels all your new reports and templates, do 
the following.

1. On the Presentation Studio Home page, click the Gear icon in the upper-right corner of 
the window. The Application Settings window opens.

Click here to access 
Application Settings
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New in Presentation Studio How do I select my language preference for Presentation Studio?
2. Select the Layout tab and, from the Report Language drop-down field, select 
a language or use the default selection (Follow User Preferences).

3. Click OK.

The default selection (Follow 
User Preferences) allows the 
language preference of the 
user working with your 
templates or reports to 
override the language you 
originally used

The language you select 
becomes the default for 
all your reports and 
templates; it will override 
the language preferences 
of others who use your 
reports and templates
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New in Presentation Studio How do I select a language preference for a report or template?
How do I select a 
language preference 
for a report or template?

When you are creating a template or report, you can select a language preference to 
override your Application Settings language selection. This selection is specific to the 
template or report. It will also override the language preference of others who use your 
template or report.

To select a report- or template-specific language, do the following:

1. In Presentation Studio, with the template or report open, select the Home tab and click 
the Workbook icon. The Workbook Settings window opens.

2. Select the Layout tab. From the Report Language drop-down field, select the language 
you want used in the report or template.

Be sure to click the Workbook 
icon on the Home tab

Your selection overrides 
the user’s language 
preference in only the 
open report or template
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New in Presentation Studio How can I update an existing report or template to match my Application Settings language preference?
3. Click OK. The following alert opens.

4. Click OK. 
5. Close and save the report, then reopen it.

How can I update 
an existing report 
or template to match 
my Application Settings 
language preference?

In most existing reports and templates, the language preference is “Follow User 
Preferences,” which means the user’s language preference will be used when they 
open the report or template.

However, when working with an existing report or template in the user who created 
the report or template made a specific language selection in their Application Settings, 
the language will not update to match your Application Settings language preference. 
You can override the language currently in use at the report or template level. 

 Note: This procedure creates an override; it does not link your report or template to your 
Application Settings language preference.

To update an existing report or template to match your language preference, do 
the following:

1. Open the report or template.
2. (Optional) If the report or template was created by another user, in the upper-left corner 

of the Presentation Studio window, click the Gear icon and from the drop-down field, 
select Save As or Save as Template.

3. Name the report or template and save it to a directory on your computer.
4. Follow the steps under How do I select a language preference for a report or template? 

on page 20. In step 2, select the language used in your Application Settings.

The effect of your language 
selection is not immediate

Note the highlighted selections
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How does 
language preference 
affect a template 
used in Report Portal?

When a Presentation Setting template is used in Report Portal, the language of the 
template is preserved. The language preference settings of the template builder or user 
have no effect.

How can I rank 
supplementary data 
points in a Performance 
Reporting table?

You can now rank investments by a supplementary data point (for example, 
Management fee), when comparing investments in a workbook.

Supplementary data points can be ranked in the following components:

gPerformance Reporting table
gPerformance Reporting extended table, and
gPlan Performance Reporting table.

To rank investments by a supplementary data point, do the following:

1. In a workbook, factsheet, or plan, select a Performance Reporting table, then 
right-click in the body of a numeric column and select Insert Rank. The Insert Rank 
drop-down field opens.

 Note: Be sure not to right-click in the column heading.

2. From the Insert Rank drop-down field, select a supplementary data point. A new 
column for that data point is inserted.

 Note: Prior to this release, the options shown in the Insert Rank drop-down field have been 
available for Performance data points, but now you can use them for Supplementary data 
points as well.

In this sample, the 
cursor was pointing at 
the YTD column during 
the right-click action
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New in Presentation Studio How can I rank supplementary data points in a Performance Reporting table?
3. Click Calculate. The values are now shown in the column.

4. Point at the new column and right-click. From the drop-down field, select Rank Order 
and then select Ascending or Descending.

 Note: The rows are sorted within their Morningstar Categories (Large Blend and Small Growth 
in the sample).

5. If you want to display the Supplementary data point (Peer group percentile in the 
sample) for all returns (1 Year, 3 Years, etc.), point at the new column and right-click. 
From the drop-down field, select Rank Order and then select Apply to All.

6. Click Calculate. 

The new column is inserted to 
the right of the column you 
right-clicked

Be sure you are pointing 
at the Supplementary 
data point column
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How do I select 
font settings for text 
components throughout 
a report or template?

It can be very time-consuming to ensure your text components’ font, size, and color are 
consistent throughout a report or template. Now you can select font settings at the 
workbook level. All text components (including those in headers and footers) added to 
the report or template will be linked to those settings. 

To select font settings at the workbook level, do the following:

1. In a report or template, select the Home tab, then click Workbook.
2. In the Workbook Settings window, select the Layout tab.
3. In the Overall Workbook section, from the Font and/or Font Color drop-down fields, 

make your selections.
4. In the Component Title Settings section, from the Font Size and/or Font Color 

drop-down fields, make your selections.
5. In the Text Component Settings section, from the Font Size and/or Font Color 

drop-down fields, make your selections.

6. Click OK.

These settings do not affect existing text components, but you will see the selected 
fonts in new text components.

To link existing text components to the Workbook font settings, see How can I apply 
the Workbook font settings to existing text components? on page 25.

Click these buttons for Bold, 
Italic, and/or Underline
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How can I apply 
the Workbook font 
settings to existing 
text components?

To apply the Workbook font settings to existing text components, do the following:

1. Select a text component and right-click.
2. From the drop-down field, select View Settings Link Status.

From this selection, you can learn 
if the component currently uses 
the Workbook font settings
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3. In the Settings Links dialog box, click the checkbox(es) of the settings you want to 
change (Text Font Type, Text Font Size, and Text Font Color).

4. Click Restore.

How can I 
change the font of a 
linked text component?

A text component that uses the Workbook Settings fonts is considered “linked” to the 
Workbook fonts. When you change the fonts used in a specific text component, the link 
is broken.

To change the font of a text component, do the following:

1. Select the text component.
2. At the top of the Presentation studio window, select the Format tab.
3. In the Style section of the Format tab, change the selection for any or all of 

the following:
g Font drop-down field
g Font size drop-down field, and
g Font properties (buttons B, I, and U for bold, italic, underline).

How can I restore 
the link to the 
Workbook settings?

To restore a text component’s link to the Workbook settings, follow the steps in How 
can I apply the Workbook font settings to existing text components? on page 25.

Because the fonts 
currently in use do 
not match the 
Workbook settings, 
the status of the font 
settings is Broken

Note the 
highlighted 
selections
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How can I customize 
the display names of 
Morningstar indexes?

In this release, you can customize the display names of Morningstar indexes, giving 
you more control over your report design and content. 

To customize the display names of Morningstar indexes, do the following:

1. On the Presentation Studio Home page, click the Gear icon in the upper-right corner of 
the window. The Application Settings window opens.

2. In the Application Settings window, select the Index Group tab.
3. Click the arrow to the left of one of the Morningstar Index groups. The group expands, 

displaying the indexes it contains.

Click here to access 
Application Settings

Click here to expand Morningstar 
Emerging Market Index
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4. In the row for the index you want to rename, click the text in the Display Name column. 
The field opens.

5. Type your preferred name in the field.
6. Click OK.

Your preferred name will be used whenever that index is accessed in a Presentation 
Studio report or template.

 Note: The new name will not be displayed in existing reports and templates.

An open field can 
be edited
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New in Report Portal

OverviewAs a Home Office administrator, you can now specify the order of factsheets in a batch 
output.

 Note: You cannot specify the output order of workbooks in a batch.

In this section, you will learn how to do the following:

g specify the factsheet order in a new batch (page 29), and
g specify the factsheet order in an existing batch. (page 31)

How do I 
specify the factsheet 
order in a new batch?

You may want to specify the order of factsheets in a batch output and have that order 
preserved every time a combined file is output.

To specify the order of factsheet output in a new batch, do the following:

1. While logged in to Report Portal as an administrator, select the Report Production tab.
2. Click New Batch to create a new batch of factsheets.

3. In the list of investments, select an investment and click one of the arrows above the 
list to move the investment.

Note the highlighted selections

Use these arrows to 
move the selected 
investment to the top 
of the list, up one 
position, down one 
position, or to the 
bottom of the list
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4. In the lower-left corner of the Factsheet - New Batch Setup dialog box, click Advanced 
Settings. The Advanced Settings dialog box opens.

5. (Optional) Click the Keep synchronization with List/Search checkbox. With this feature 
enabled, the report will synchronize to your list or search as follows:
g If an investment is added to the list or search, it will be added to the end of the 

batch list, and
g If an investment is deleted from the list or search, it will be removed from the 

batch list.

6. Click the Combine all reports into a single file checkbox. 

7. Fill in the fields to create the combined file name.
8. Click OK to close the Advanced Settings dialog box.
9. Run or Schedule the batch as usual and Save.

Click here to 
access the 
Advanced 
Settings

Note the highlighted selections
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How do I specify the 
factsheet order in an 
existing batch?

You can specify the output order in an existing batch. Do the following:

1. While logged in to Report Portal as an administrator, select the Report Production tab.
2. In the list of batches, double-click the batch you want to edit. The Batch Setup dialog 

box opens.

 Note: Reordering the output is allowed only in batches of factsheets.

3. In the list of investments, select an investment and click one of the arrows above the 
list to move the investment.

4. In the lower-left corner of the Factsheet - New Batch Setup dialog box, click Advanced 
Settings. The Advanced Settings dialog box opens.

Use these arrows to move the 
selected investment to the top 
of the list, up one position, 
down one position, or to the 
bottom of the list

Click here to 
access the 
Advanced 
Settings
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5. Click the Combine all reports into a single file checkbox. 

6. Fill in the fields to create the combined file name.
7. Click OK to close the Advanced Settings dialog box.
8. Click Save.

Note that in an existing 
batch, you do not have the 
option to synchronize with 
the list or search
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New in Morningstar Direct Desktop

OverviewIn this release, the Morningstar Publications tab has been retired but you can access 
Morningstar Research publications via Morningstar Direct Cloud.

The Equity Quicktake is being replaced by the Equity Signature Asset Library (SAL) 
report. The Equity Quicktake is still available and you can access the Equity SAL report 
from there.

In this section, you will learn how to do the following:

g access Morningstar Research publications via Morningstar Direct Cloud 
(page 33), and

g access the Signature Asset Library (SAL) report from the Equity Quicktake 
(page 35).

How can I 
access Morningstar 
Research publications?

Although the Morningstar Publications tab is now longer available, you can still access 
all Morningstar Research publications via Morningstar Direct Cloud. Do the following:

1. In a web browser, go to https://direct.morningstar.com and log in, using your 
Morningstar Direct credentials.

2. On the Morningstar Direct Cloud Home page, in the Research area, click the 
Publications link. The Publications page opens.

New content and 
insights from 
Morningstar’s 
analysts are posted 
frequently in the 
Research app
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3. Click the name of the publication you wish to access.

 Note: You may need to scroll to view all publications.

The publications are initially alphabetized by publication name. 

Click the Sort icon to 
reorder the links by 
recently updated or 
date added

Click the Filter icon 
to focus on equity, 
manager, credit, 
or macro

The most recent 
update is listed for 
each publication
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How do I access 
the Equity SAL from 
the Equity Quicktake?

The Equity Quicktake is being replaced by the Equity SAL report for better function and 
usability. Equity Quicktake is still available and you can access Equity SAL from there.

To access the Equity SAL report from the Equity Quicktake, do the following:

1. In an investment list or performance report in Morningstar Direct, double-click the 
name of an equity. The Quicktake Snapshot opens.

2. At the top of the Quicktake Snapshot, to the left of Quicktake PDF, click the link to 
navigate to the SAL report. The SAL report opens in a browser tab.

Click this link to 
open the SAL report

The SAL report includes 
Morningstar’s quantitative 
fair value estimate for 
full coverage of the 
stocks universe
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New in Morningstar Excel Add-In

OverviewThe new features in the Morningstar Excel Add-In give you control over when calculations 
are processed, and support currency conversion for NAV-related data points.

In this section, you will learn about the following:

gdisabling automatic calculations (page 36)
gmanually initiating calculations (page 37), and
g currency conversion in all NAV-related data points (page 37).

How can I disable 
automatic calculations?

The Morningstar Excel Add-In defaults to immediately begin processing a function 
calculation. An option has been added to allow you to disable automatic calculation so 
you can manually initiate the calculations at a later time.  

To disable immediate calculations, do the following:

1. In Microsoft Excel, select the Morningstar tab.
2. Click the Profile icon and, from the Profile drop-down field, select Preferences.

Note the highlighted selections
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3. In the Preferences dialog box, clear the Auto calculate checkbox.

4. Click OK.

How do I 
manually initiate 
calculations?

When auto-calculation is disabled, you must manually initiate calculations. To do so, 
simply refresh the data as follows:

1. With a spreadsheet open, select the Morningstar tab.
2. (Optional) If you want to refresh specific cells, select them. If you want to refresh a 

specific sheet, make sure the sheet is displayed.
3. In the Refresh section of the Morningstar tab, click one of the following:

gCell (if you want to refresh only the selected a cell or cells)
gSheet (if you want to refresh only the displayed sheet), or
gWorkbook (if you want to fresh the entire workbook (all sheets and cells).

What do I 
need to know about 
currency conversion for 
NAV-related data points?

The Morningstar Excel Add-In now supports currency conversation for all 
NAV-related data points (Cum_Fair_Nav - DilutedFairValueCumIncome and 
Ex_Par_Nav - DilutedParValueExIncome).

Currency conversion is automatic and no user action is necessary. 

Auto calculate is on by default

Note the highlighted selections
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